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Introduction
Cisco Supervisor Desktop for Cisco Unified Contact Center Express (Unified CCX) is a
robust computer telephony integration solution for IP-based contact centers that is
easy to deploy, configure, and manage. It provides supervisors with powerful tools to
increase productivity and improve customer satisfaction.
Supervisor Desktop’s features allow you to view real time statistics, monitor and
coach agents, barge-in, intercept, and record active agent calls when necessary,
enabling effective management of agent resources.

What’s New in This Release
Cisco Supervisor Desktop 10.5 includes the following new features:
■

Support for Internet Explorer 11

■

Support for JRE 1.7 Update 51

Obtaining Documentation and Submitting a Service
Request
For information on obtaining documentation, submitting a service request, and
gathering additional information, see the monthly What’s New in Cisco Product
Documentation, which also lists all new and revised Cisco technical documentation,
at:
http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
Subscribe to the What’s New in Cisco Product Documentation as a Really Simple
Syndication (RSS) feed and set content to be delivered directly to your desktop using a
reader application. The RSS feeds are a free service and Cisco currently supports RSS
version 2.0.

June 18, 2014
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Documentation Feedback
You can provide comments about this document by sending email to the following
address:
ccbu_docfeedback@cisco.com
We appreciate your comments.
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Supervisor Desktop Feature Levels
There are three feature levels of Cisco Supervisor Desktop: Standard, Enhanced, and
Premium.
The following table outlines the features that are available at each feature level. All
features not listed here are present in all three feature levels.
Feature

Standard

Enhanced Premium

Silent monitoring

×

×

Barge-in

×

×

Intercept

×

×

Recording

×

×

Chat with team members (CAD agents only)

×

×

Team messages (TMs)

×

×

E-mail Contact Service Queues (CSQ)

×

Supervisor work flows—threshold alerts for tree
control actions

×

Supervisor work flows—all actions except
threshold alerts for tree control actions
Real time displays (text)
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×
×

×

×

×

Real time displays (charts)

×

Web page push to agents

×

Contact Service Queue statistics

×

×

×

Cisco Unified Personal Communicator

×

×

×
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Starting Supervisor Desktop
If you want to use all of the functionality of Supervisor Desktop, you must first log into
Agent Desktop. For more information, see the Cisco Agent Desktop User Guide.
To start Supervisor Desktop:

1. Choose Start > Programs > Cisco > Desktop > Supervisor. The login dialog box
appears (Figure 1).
Figure 1.

Supervisor Login dialog box

2. Enter your Supervisor Desktop login ID and password in the appropriate fields,
and then click OK or press Enter. Supervisor Desktop starts, but does not
show any data and the status bar displays “No Service”.
3. From the Team drop-down list, select a team.
4. If your configuration includes Cisco Unified Presence and you have chosen to
log into Unified Presence through Supervisor Desktop (see "Logging into Cisco
Unified Presence" on page 11) and your Unified Presence login is different
from your Supervisor Desktop login, the Cisco Unified Presence Server Login
dialog box appears (Figure 2). Type your Unified Presence username and
password and click Login.
Figure 2.
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Cisco Unified Presence Server Login dialog box
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NOTE: In a high availability over WAN triangle configuration (both
servers and the CAD client applications communicate over a WAN)
when the WAN link between the two servers is down, Supervisor
Desktop might not function properly and you might not be able to see
all active agents.
The first time you log into Supervisor Desktop:
■

Your user ID and password are the same as your Agent Desktop user ID and
password.

■

The User ID field is empty. The next time you log in, the User ID field is
automatically filled with the information you entered before. If you share a
computer with another supervisor, verify that this field has your information
and not the other supervisor’s information.

■

It might take some time for Supervisor Desktop to start because default
report data must be generated.

Logging into Cisco Unified Presence
You can log into Cisco Unified Presence through any one of the following applications:
■

Agent Desktop

■

Supervisor Desktop

■

Cisco Unified Personal Communicator
IMPORTANT: Do not log in to Unified Presence through more than one
application, even using different user IDs. Unified Presence cannot
communicate with more than one client application on any one
computer.

By default, Supervisor Desktop assumes that you log into Unified Presence through
Agent Desktop. If you choose to log in through Supervisor Desktop, you must configure
this option (Enable Cisco Unified Presence) through the Preferences window. See
"Setting Preferences" on page 18 for more information.
Information from Unified Presence (for example, non-agent subject matter experts and
personal contacts) appears only in the Contact Selection window accessed from the
application through which you logged into Unified Presence.
For example, if you log into Unified Presence through Supervisor Desktop, the
Supervisor Desktop Contact Selection window will display Unified Presence
information, agents, and supervisors, and the Agent Desktop Contact Selection
window will display only agents and supervisors.

June 18, 2014
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If you log in to Unified Presence through Unified Personal Communicator, neither
Supervisor Desktop nor Agent Desktop will display Unified Presence information, and
Unified Personal Communicator will not display agent and supervisor information.

Access Through a VPN From Behind a NAT Firewall or
Router
Supervisor Desktop is able to connect to the CAD servers through a virtual private
network (VPN). This allows an agent to work remotely and still have the benefits of the
full functionality of Supervisor Desktop.
Using a VPN is recommended in order to provide a more secure connection.
When a desktop is using network address translation (NAT) due to a firewall or router,
then VPN software must be used on the desktop to ensure full bi-directional network
connectivity between the contact center servers and the desktop. Failure to use VPN
software will result in connectivity issues and a loss in functionality such as silent
monitoring, recording, and incoming chat message and team message failures.
Cisco AnyConnect Secure Mobility Client is verified to work properly and is supported
for access with Supervisor Desktop.
VPN solutions from other vendors might result in feature loss. Because they have not
been formally verified, they are not supported.
NOTE: After installing the Cisco AnyConnect Secure Mobility Client,
you must restart your computer. If you do not restart, monitoring and
recording will not work.

VPN Tunneling
There are two types of VPN tunneling mechanism, full tunneling and split tunneling,
both of which are supported for connection between Supervisor Desktop and CAD
services.
VPN Full Tunneling

VPN full tunneling virtually replaces the network connection with the local area
network defined by the VPN. If VPN full tunneling is used to connect to CAD servers,
the VPN connection must be established before starting Supervisor Desktop. If the
VPN connection is lost during a session, you must close Supervisor Desktop,
reestablish the VPN connection, and then restart Supervisor Desktop.
VPN Split Tunneling

VPN split tunneling allows you to access a public network and a local area network
simultaneously, using the same physical network connection.

12
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There are two types of VPN split tunneling scenarios.
■

Scenario 1: The CAD servers are on the public network and a third-party
application is used through the VPN. In this scenario, you must launch and log
into Supervisor Desktop before establishing the VPN connection. If the VPN
connection is lost during a session, you must restart Supervisor Desktop and
then reestablish the VPN connection.

■

Scenario 2: The CAD servers are on the VPN and a third-party application is
used through the public network. In this scenario, you must establish the VPN
connection before launching Supervisor Desktop. If the VPN Connection is
lost during a session, you must close Supervisor Desktop, reestablish the VPN
connection, and then restart Supervisor Desktop.

If Supervisor Desktop can log into all services except the Chat service, it must be
restarted after the Chat service comes back online.

June 18, 2014
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Automated Updates
CAD enables your administrator to update all instances of the CAD desktop
applications automatically to a newer version. It also ensures that the correct version
of Java Runtime Environment (JRE) is installed on your computer.

CAD Desktop Applications
Every time you launch Supervisor Desktop, the software checks to see if there is an
updated version available, or if there was a system configuration change that requires
a Windows registry change. If either of these conditions exists, the software
automatically runs the update process.
When an update is available, you will see a dialog box notifying you that your copy of
Supervisor Desktop will be updated. Click OK to proceed with the update.
A progress bar is displayed to show you the status of the update process.
When the update is finished, you will see a final dialog box that tells you that the
update is complete, and which applications were updated. If you have other CAD
desktop applications (Cisco Agent Desktop and Cisco Desktop Administrator) on your
PC, they will all have been updated.
NOTE: Enhanced and Premium packages only: Because Agent
Desktop is automatically installed when Supervisor Desktop is
installed, only Supervisor Desktop will be listed as having been
updated in the final dialog box. Agent Desktop will be listed only if
Supervisor Desktop is not present on your PC.
When you click OK to close the dialog box, any CAD desktop application running on
your desktop restarts automatically.
NOTE: To ensure that automated updates function correctly, you
must configure Internet Explorer so that it checks for newer versions
of stored pages. To configure this setting, launch Internet Explorer
and choose Tools > Internet Options. In the Browsing history section
on the General tab, click Settings. Select the option labeled Every
time I visit the web page.

14
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NOTE: If your system is configured with two Unified CCX servers, and
one server is upgraded while your instance of Supervisor Desktop is
connected to the older Unified CCX server, and your administrator
performs a failover to switch all agents to the upgraded server, your
instance of Supervisor Desktop will not automatically upgrade when
you log into the new server. You must shut down Supervisor Desktop
and start it again for the automatic upgrade to take place.

Java Runtime Environment
Every time Supervisor Desktop is launched, it checks to see if the correct version of
JRE is installed. If the correct version is not detected, you will be notified, and
Supervisor Desktop will download and install the correct JRE.

June 18, 2014
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The Supervisor Desktop Window
The Supervisor Desktop window is divided into five areas:
■

The Skill Groups tree, which lists all of the CSQs associated with the team you
choose from the team selection list

■

The agents tree, which lists all of the agents and supervisors on the team

■

Tabular/graphical real time displays of CSQ information

■

Tabular/graphical real time displays of agent and team information

■

Integrated browser (if enabled)

The Supervisor Desktop interface is highly configurable. By default, the browser is not
enabled and the panes are not dockable. However, you can configure real time
displays, enable the integrated browser, and enable all panes to act as dockable
windows (so you can move them and resize them independently). You can also change
the size of the toolbar icons from the default 16 × 16 pixels to 32 × 32 pixels.
The specific panes that are displayed depends on the nodes that you select in the Skill
Groups and Agents tree. If you choose to enable the integrated browser, the real time
displays and the browser appear on tabs in the right pane. Figure 3 shows the
Supervisor Desktop window in its default configuration.
Figure 3.
Team
selection
Skill Groups
(CSQ) tree

Agents tree

Supervisor Desktop interface
Integrated
browser and
real time
display tabs

Real time
displays

Status bar
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Real time display panes are identified as containing information related to voice CSQs,
e-mail CSQs, or agents by the text in their title bars (Figure 4).
Figure 4.

Identifying real time displays
Displays containing E-Mail
CSQ information and Agents
information.
These displays are in
“movable windows” mode:
able to be resized and moved
anywhere on the desktop

When Supervisor Desktop is in default layout (movable windows are disabled), CSQ
real time displays occupy approximately the top half of the right pane, and the Agents
real time displays occupy approximately the lower half of the right pane. The tree
panes and real time display panes can all be resized by dragging the horizontal
splitters up and down and the vertical splitters left and right.
If you choose to enable movable windows (see Setting Preferences on page 18), all of
the real time display panes can be resized and moved anywhere on your desktop.
However, each type of display can only dock to another display of its own type. In other
words, CSQ displays dock to other CSQ displays and Agent displays dock to other
Agent displays. For example, you cannot separate one Agent display from another
Agent display, although they can be resized in relationship to each other (Figure 5).

June 18, 2014
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Figure 5.

Example of rearranged and resized displays

You can also drag the vertical splitter between the trees panes and the display panes
left or right, and the horizontal splitter between the two trees panes up and down.
If you choose to enable the integrated browser, the real time displays and the browser
appear on tabs in the area to the right of the Skill Groups and Agents navigation trees.

Setting Preferences
The Preferences dialog box controls what information is displayed in the display panes
and how those panes behave. Table 1 summarizes what you can configure using
Preferences.
Table 1.

Configurable elements of the Supervisor Desktop interface

Tree Control
Node

Available Displays

CSQs
Voice > CSQ

18

Configure
Columns?

Configure
Graphs?

Configure
Refresh?

Team Summary

Yes

Yes

Yes

Summary

Yes

No

Yes

Detail

Yes

Yes

No
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Table 1.

Configurable elements of the Supervisor Desktop interface (cont’d)

Tree Control
Node

Configure
Columns?

Configure
Graphs?

Configure
Refresh?

Summary

Yes

No

Yes

Detail

Yes

No

Yes

Assigned

Yes

No

Yes

Queued

Yes

No

Yes

Resolved

Yes

No

Yes

Team Summary

Yes

Yes

Yes

Team State

Yes

Yes

No

Agent vs. Team
Summary

Yes

Yes

Yes

State

Yes

No

No

Call

Yes

No

No

Active Call

Yes

No

No

Enterprise Data

Yes

No

No

Enterprise Call History

Yes

No

No

E-Mail

Active E-Mail

Yes

No

No

Browser

Supervisor browser
tabs

—

—

—

E-Mail > CSQ*

Team
Agent
Logs

Calls

Available Displays

* Premium feature level only.

June 18, 2014
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To set your interface preferences:

1. Choose View > Preferences. The Preferences dialog box appears (Figure 6).
Figure 6.

Preferences window

2. In the left pane, select a node. The right pane displays that node’s settings.
NOTE: If a display element is disabled, it cannot be configured.
3. If you want to configure the columns that are displayed, complete the
following steps:
a. Select Columns and click the ellipsis (…). The Configure Columns dialog
box appears.
b. Select the columns you want to appear in the display. Use the up and
down arrows to set the order in which you want them to appear.
c. Click OK when done.
4. If you want to configure the chart that is displayed, complete the following
steps.
a. Select Graphical displays and click the ellipsis (…). The Select charts
dialog box appears.
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b. Select the chart you want to appear in the display, then click OK. You can
select only one chart for each real time display.
5. If you want to configure the refresh rate, select Refresh rate (in seconds) and
adjust the rate.
6. If you want to be able to rearrange the real time display panes, select the
Enable movable windows check box.
7. If you want the toolbar icons to be 32 × 32 pixels instead of the default
16 × 16 pixels, select the Enable Large Toolbar Icons check box.
8. If you want to have access to the integrated browser in Supervisor Desktop,
select the Enable Integrated Browser check box.
■

To configure a home page that is different from the default of
www.cisco.com, select the Browser node in the left pane. Enter a URL in
the Browser Home Page field in the right pane, and then click OK.

■

If you want to have access to more than one browser tab, complete the
following steps.
a. Select the Browser node in the left pane.
b. Select a number from 1 to 10 in the Number of Browser Tabs field in
the right pane.
c. For each additional browser tab, select the tab from the Browser Tab
field, then enter a URL in the Browser Home Page field. If you do not
enter a home page or you delete an existing URL, the tab will use the
Cisco home page (www.cisco.com).

9. If you want to have access to the Unified Presence server, select the Enable
Cisco Unified Presence check box. You must restart Supervisor Desktop (and
Agent Desktop, if that is running) for this setting to take effect.

Agents Tree
The Agent tree displays all agents and supervisors on the selected team who are
currently logged in, and any calls (ACD and non-ACD) they are on. The icon next to the
agent’s name indicates which agent state the agent is in (see "Toolbar Buttons and
Shortcut Keys" on page 24 to see examples of the agent state icons).
In addition to the agent state icons, this icon
Not Ready state and is on a call.

indicates that an agent is in the

If an agent device is multi-line–enabled, an asterisk next to an inbound or outbound
call indicates that the call is on an ACD line.
NOTE: If you have the Standard feature level, only IP Phone agents
appear in the agents tree.

June 18, 2014
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NOTE: If an agent’s team assignment is changed, the change does
not go into effect until the CAD desktop applications are restarted.

Formatting Agent Names in the Agents Tree
The Preferences dialog box enables you to control how agent names are displayed in
the agents tree.
An agent can be identified by any or all of the following:
■

Name

■

Extension

■

Application used by the agent (CAD or Cisco IP Phone Agent (IPPA))

At least one of these must be selected to identify an agent in the agents tree. If all
options are selected, the information in the agents tree appears as follows:
Jane Smith x1500 CAD
In this example, Jane Smith is a CAD agent. Her extension is 1500.
To format agent names in the agents tree:

1. Choose View > Preferences, and then select the Agents node.
2. In the Format node text grid, check the elements you want to use to identify
an agent. You must select at least one element. A sample of what the name
will look like appears on the Sample line.
3. Click OK.

Restoring the Interface Default Layout
To restore Supervisor Desktop to its default layout, open the Preferences window
(choose View > Preferences) and click Restore Default Layout.
Clicking this button makes the following changes:

22

■

In the Real Time Displays pane, moves displays to their default positions

■

Disables the integrated browser

■

Disables movable windows

■

Disables any graphical real time displays you selected previously

■

Resets the toolbar buttons to the default size

■

Resets the report font to the default size

■

Disables Cisco Unified Presence
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■

Disables Cisco Web Chat

Clicking this button does not make any of the following changes. You must manually
resize the columns yourself and reset the other two elements to their default settings
in the Preferences window (see "Setting Preferences" on page 18).
■

Resize columns to their default widths

■

Restore columns to real time displays that you removed previously

■

Reset the report font size to the default (15)

Agent E-Mail Viewer
You can view customer e-mail messages, along with any agent responses and any
attachments, in the Agent E-Mail Viewer.
You can view any e-mail listed in the Assigned, Queued, or Resolved real time displays
or under the E-Mail node in the Agents tree. For more details on E-Mail CSQ real time
displays, see "Real Time Displays" on page 28.
Table 2 lists the fields in the Agent E-Mail Viewer.
Table 2.

Agent E-mail Viewer fields

Field

Description

From

The sender of the e-mail.

To

The recipient of the e-mail.

Cc

The external e-mail addresses of the recipients copied in
on the e-mail, if any.

Subject

The subject of the e-mail.

Sent

The date and time when the customer sent the e-mail.

Received

The date and time when the e-mail was received.

Handled By

The name of the agent handling the e-mail.

Handled Date

The date and time when the agent replied to the
customer.

To view an e-mail using the Agent E-Mail Viewer:

1. Double-click an e-mail from the Assigned, Queued, or Resolved real time
display or under the E-Mail node in the Agents tree. The e-mail opens in the
Agent E-mail Viewer.

June 18, 2014
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2. Double-click any inbound or outbound attachment. The attachment opens in
an application based on the attachment format.
NOTE: Although you can edit opened attachments, those changes are
not saved and will not appear in the e-mail attachment when
reopened.

Accessibility
Supervisor Desktop has a number of features that aid accessibility by vision-impaired
users. These features are the following:
■

Follows Windows settings for screen resolution and color/contrast settings
NOTE: Enable high contrast before launching Supervisor Desktop to
ensure that all tables match the high contrast settings.

■

Choice of small (16 × 16 pixels) or large (32 × 32 pixels) toolbar icons (see
"Setting Preferences" on page 18)

■

Screen reader-compatible tool tips for all controls

■

Screen reader-compatible shortcut keys for navigating the application and
toolbar (see "Toolbar Buttons and Shortcut Keys" on page 24)

■

Improved support for Job Access With Speech 11 (JAWS)

Toolbar Buttons and Shortcut Keys
The following tables list the toolbar buttons and shortcut keys that you can use to
navigate Supervisor Desktop.
Table 3 lists the toolbar buttons and shortcut keys for refreshing the data display.
Table 3.

Icon

24

Refreshing the data display toolbar buttons and shortcut keys

Name

Shortcut

Description

Refresh

Ctrl+F

Refreshes the information in the Skill Groups tree and
the Team Agent State Display data view pane that has
changed since the last sync.
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Table 4 lists the toolbar buttons and shortcut keys for changing an agent’s state.
Table 4.

Icon

Agent state toolbar buttons and shortcut keys

Name

Shortcut

Description

Logout

Ctrl+L

Logs the selected agent out of the ACD.

Ready

Ctrl+E

Changes the selected agent’s state to Ready.

Not Ready

Ctrl+N

Changes the selected agent’s state to Not Ready.

Work

Ctrl+D

Changes the selected agent’s state to Work
Ready.

Table 5 lists the toolbar buttons and shortcut keys for call handling.
Table 5.

Icon

Call handling toolbar buttons and shortcut keys

Name

Shortcut

Description

Barge-in

Ctrl+B

Enables you to join an agent’s phone conversation.

Intercept

Ctrl+I

Enables you to intercept a call while disconnecting
the agent from the call.

Table 6 lists the toolbar buttons and shortcut keys for communicating with your team
and other supervisors.
Table 6.

Icon

—

Team communication toolbar buttons and shortcut keys

Name

Shortcut

Description

Chat

Ctrl+J

Opens the Chat Selection window.

Team Message

Ctrl+X

Opens the Team Message window.

Coach by
Pushing a Page

Ctrl+U

Opens the Push URL to Agent window.

Table 7 lists the toolbar buttons and shortcut keys for recording calls.
Table 7.

Icon

June 18, 2014

Recording toolbar buttons and shortcut keys

Name

Shortcut

Description

Start Record

Ctrl+R

(Enhanced/Premium only). Starts recording the
selected call.
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Table 7.

Icon

Recording toolbar buttons and shortcut keys

Name

Shortcut

Description

Stop Record

Ctrl+S

(Enhanced/Premium only). Stops recording the
selected call.

Table 8 lists the toolbar buttons and shortcut keys for monitoring agents.
Table 8.

Icon

Voice monitoring toolbar buttons and shortcut keys

Name

Shortcut

Description

Start Voice Monitor

Ctrl+A

Starts monitoring the selected agent.

Stop Voice Monitor

Ctrl+P

Stops monitoring the selected agent.

Voice monitor volume

Ctrl+V

Opens a volume slider control.

Table 9 lists the shortcut keys for keyboard accessibility.
Table 9.

Accessibility shortcut keys

Shortcut Keys

Description

Ctrl+Shift+S

Selects the Skill Groups node in the Skill Groups tree.

Ctrl+Shift+A

Selects the Agents node in the Agents tree.

Ctrl+Shift+B

Shifts focus to the browser pane.

Ctrl+Shift+R

Shifts focus to the Real Time Displays.

Ctrl+Shift+T

Selects the Team node in the Agents tree.

Ctrl+H

Selects the Team Selection List.

Ctrl+T

Shifts focus to what was previously selected in the Agents tree.

Ctrl+Shift+H

Opens the Service Status window.

Once you have set focus to the Skill Groups tree, the Agents tree, or the team node in
the agents tree, you can use the tab key to navigate to the real time display panes.
Once your focus is in a real time display pane, you can use the arrow keys to navigate
around the display grid.
NOTE: The tab key will move you among the real time display panes,
but the order in which you access them will not necessarily be in sync
with the physical arrangement of the display panes on your desktop.
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The Supervisor Desktop Window

Integrated Browser Pane
The integrated browser pane allows you to view internet and intranet web pages to
help you assist agents and customers. The integrated browser has from 1 to 10 tabs,
each of which can display a different web page. You can configure each tab to display
a specific website.
For more information about this pane, see "Using the Integrated Browser" on page 67.

Status Bar
The status bar (Figure 7) displays current information about Supervisor Desktop.
Figure 7.

Status bar

Current system time in 24-hour format
Current status of Supervisor Desktop features
Login ID
User name

In the event of a service failure, the Current Status section changes from “In Service”
to “Partial Service” or “No Service.” To learn which features are affected by the service
outage, double-click the Current Status section of the status bar to view a popup
window that displays active or inactive features.

June 18, 2014
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Real Time Displays
The real time displays contain the information you need to manage your teams and
agents. Real time displays include the following:
■

Agent – Agent vs. Team Summary (page 29)

■

Agent Contact – Active Call (page 32)

■

Agent Contact – Active E-Mail (page 32)

■

Agent Contact – Enterprise Call History (page 33)

■

Agent Contact – Enterprise Data (page 34)

■

Agent Logs – Call (page 34)

■

Agent Logs – State (page 34)

■

Agents – Team State (page 35)

■

Agents – Team Summary (page 36)

■

E-Mail CSQ – Assigned (page 37)

■

E-Mail CSQ – Detail (page 38)

■

E-Mail CSQ – Queued (page 39)

■

E-Mail CSQ – Resolved (page 40)

■

E-Mail CSQ – Summary (page 41)

■

E-Mail CSQ – Team Summary (page 42)

■

Voice CSQ – Detail (page 44)

■

Voice CSQ – Summary (page 45)

■

Voice CSQs – Team Summary (page 47)

There are two types of displays: tabular and graphical.
■

Tabular displays present skill group, team, and agent information in a grid.
Tabular information can be sorted in ascending/descending order by clicking
any column header in the grid. You can sort by one column only.

■

Graphical displays present the same information as bar charts, except for the
Agent vs. Team Statistics, which is presented as two pie charts.
NOTE: Graphical displays are available at the Premium feature level
only.

For e-mail related actions, Supervisor Desktop generates new logs as
EemSupervisor.log and EemSupervisor.dbg.
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Agent – Agent vs. Team Summary
The Agent vs. Team Summary display is available when you select a specific agent in
the Agents tree. This display presents the performance details for the agent and
compares them to the performance details of the team.
The data is obtained from the CAD Recording & Statistics service, and is for the
current day starting at midnight. The data refresh rate is configurable and ranges from
every 5 to 30 seconds. By default it is every 15 seconds.
The graphical display (Figure 8) is presented as two pie charts. These pie charts show
the percentage of time a specific agent spends in various ACD states in comparison to
the percentages spent by the team as a whole.
NOTE: Percentages in the pie chart are rounded to two decimal
places. As a result, the total of all percentages might not equal 100%.
NOTE: If Other Time is a small value, it might not show up as a slice in
the graphical display pie chart.
Figure 8.
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Agent vs. Team Percent Time in State graphical display
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Table 10 lists the fields in the Agent vs. Team Summary display.
Table 10.
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Agent vs. Team Summary display data

Column Name

Description

ID

Identifies the statistics as for the selected agent or the
team.

Logon Time

The amount of time (in seconds) since midnight the
agent and team have been logged into Agent Desktop.

Calls Presented

The number of inbound calls (ACD and non-ACD)
presented to the agent since midnight.

Calls Handled

The number of inbound calls (ACD and non-ACD)
presented to and answered by the agent since midnight.

Max Talking

The longest talk time (in seconds) of all calls handled
since midnight.

Avg Talking

The average talk time and hold time (in seconds) of all
calls handled since midnight.

Total Talking

The total Reserved time, talk time, and hold time (in
seconds) of all calls handled today.

Max Ready

The longest time (in seconds) spent in the Ready state
since midnight.

Avg Ready

The average time (in seconds) spent in the Ready state
since midnight.

Total Ready

The total time (in seconds) spent in the Ready state
since midnight.

Max Not Ready

The longest time (in seconds) spent in the Not Ready
state since midnight.

Avg Not Ready

The average time (in seconds) spent in the Not Ready
state since midnight.

Total Not Ready

The total time (in seconds) spent in the Not Ready state
since midnight.

Max After Call Work

The longest time (in seconds) spent in the Work state
since midnight.

Avg After Call Work

The average time (in seconds) spent in the Work state
since midnight.

Total After Call Work

The total time (in seconds) spent in the Work state since
midnight.
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Table 10.

June 18, 2014

Agent vs. Team Summary display data (cont’d)

Column Name

Description

Other Time

The total time (in seconds) spent in states other than
Talking, Ready, Not Ready, Reserved, and Work since
midnight.

E-Mails Retrieved

The number of e-mails received since midnight.

E-Mails Sent

The number of e-mails sent since midnight.

Max Processing

For all sent e-mail, the longest time (in seconds) spent in
the E-Mail Processing state with the e-mail in focus since
midnight. All processing time is included, whether it
occurred before or after midnight.

Avg Processing

For all sent e-mail, the average time (in seconds) spent
in the E-Mail processing state with the e-mail in focus
since midnight. All processing time is included.

Total Processing

For all sent e-mail, the total time (in seconds) spent in
the E-Mail Processing state with the e-mail in focus since
midnight. All processing time is included, whether it
occurred before or after midnight.

Max On Desk

For all sent e-mail, the maximum time (in seconds) an
e-mail spent on desk since midnight. On-desk time
begins when an agent receives an e-mail and ends when
the agent sends a reply to that e-mail. All on-desk time is
included, whether it occurred before or after midnight.

Avg On Desk

For all sent e-mail, the average time (in seconds) an
e-mail spent on desk since midnight. On-desk time
begins when an agent receives an e-mail and ends when
the agent sends a reply to that e-mail. All on-desk time is
included, whether it occurred before or after midnight.

Max E-Mail Ready

The longest time (in seconds) spent in the E-Mail Ready
state since midnight.

Avg E-Mail Ready

The average time (in seconds) spent in the E-Mail Ready
state since midnight.

Total E-Mail Ready

The total time (in seconds) spent in the E-Mail Ready
state since midnight.

Max E-Mail Not Ready

The longest time (in seconds) spent in the E-Mail Not
Ready state since midnight.

Avg E-Mail Not Ready

The average time (in seconds) spent in the E-Mail Not
Ready state since midnight.
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Table 10.

Agent vs. Team Summary display data (cont’d)

Column Name

Description

Total E-Mail Not Ready

The total time (in seconds) spent in the E-Mail Not Ready
state since midnight.

Agent Contact – Active Call
The Active Call display is available when you select an active call under a specific
agent’s name in the Agents tree. This display presents information about each party in
the current active call. The data refresh rate is 1 second, and is not configurable.
Table 11 lists the fields in the Active call display.
Table 11.

Agent Active Call display data

Column Name

Description

Name

Name of the parties in the call, if known. If this data is
not known, <unavailable> is displayed.

Number

The party’s phone number.

Call Status

Hook state of the party (Active or Held).

Duration

The length of time the party has been in the call.

Contact Service Queue

The ID of the CSQ that the call was queued to, if
applicable.

Agent Contact – Active E-Mail
The Active E-Mail display is available when you select the E-Mail node underneath a
specific agent’s name in the Agents tree.
You can view an e-mail along with any inbound and outbound attachments in Agent
E-Mail Viewer by double clicking the email from any of the Real Time Displays.
This display presents a summary of the e-mails the agent is working on. The data is for
the current day starting at midnight. The data refresh rate is 1 second, and is not
configurable. Table 12 lists the fields in the Active E-mail display.
Table 12.
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Active E-Mail display data

Field

Description

From

The sender of the e-mail.

To

The recipient of the e-mail.
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Table 12.

Active E-Mail display data (cont’d)

Field

Description

Subject

The subject of the e-mail.

Date Received

The date the e-mail was received.

Date Retrieved

The date the e-mail was retrieved from the queue by the
agent.

In Process Duration

The length of time the agent spent processing the
e-mail. Processing time includes all time that the agent
was in E-Mail Processing state with the e-mail in focus.

On Desk Duration

The length of time the e-mail was on the agent’s desk.
On-desk time begins when an agent receives an e-mail
and ends when the agent sends a reply to that e-mail.

Contact Service Queues

The name of the CSQ to which the e-mail was routed.

Agent Contact – Enterprise Call History
The Enterprise Call History display is available when you select an active call under a
specific agent’s name in the Agents tree. This display presents a history of the call’s
presence in the contact center. The data refresh rate is 1 second, and is not
configurable. Table 13 lists the fields in the Enterprise Call History display.
Table 13.

Enterprise Call History display data

Column Name

Description

Threshold

The acceptable amount of time a call can remain at a
particular device or contact center. The administrator
might assign caution and warning threshold values to
each device type, as well as a total threshold value for a
call.
If a call remains at a device longer than the defined
caution and warning thresholds, a caution or warning
icon is displayed in this field.

June 18, 2014

Device

A device that the call has passed through.

Type

The type of device the call has passed through.

Description

Description of the device.

Duration

The amount of time the call spends at a device.
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Agent Contact – Enterprise Data
The Enterprise Data display is available when you select an active call under a specific
agent’s name in the Agents tree. The data displayed is configured by your
administrator. The data in the report can be refreshed manually by clicking the
Refresh button on the toolbar.

Agent Logs – Call
The Call display is available when you select the Logs node underneath a specific
agent’s name in the Agents tree.
This display presents a history of the calls made and received by the agent during the
current session. By default, the data displayed is sorted in ascending order by time of
day. The data in the report can be refreshed manually by clicking the Refresh button
on the toolbar. Table 14 lists the fields in the Call display.
Table 14.

Call display data

Column Name

Description

Start Time

The time the call was answered.

Direction

Inbound or outbound call.

Answered

(Yes/No) Answered or unanswered call.

Calling Party

The originating phone number.

Called Party

The recipient phone number.

Call Duration

The length of the call.

Agent Logs – State
The State display is available when you select the Logs node underneath a specific
agent’s name in the Agents tree.
This display presents a history of the ACD states the agent transitioned through during
the current session. By default, the data displayed is sorted in ascending order by time
of day. The data in the report can be refreshed manually by clicking the Refresh button
on the toolbar. Table 15 lists the fields in the State display.
Table 15.
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State display data

Column Name

Description

Start Time

The time the agent state was initiated.

Agent State

The ACD agent state.
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Table 15.

State display data (cont’d)

Column Name

Description

Wrap-up Data

Any wrap-up data the agent entered, if the agent state
transitioned to after ending a call or sending an e-mail is
Work (after-call work).

Reason Code

Any reason code the agent entered, if the agent state
transitioned to is Not Ready or Logout (if required).

State Duration

The length of time the agent was in the agent state.

Agents – Team State
The Team State display is available when you select the Team node or Agents node in
the Agents tree. This display presents the current agent state status for each agent on
the team. By default, the data displayed is sorted in ascending order by agent name.
NOTE: If the agent is assigned to a new team while logged in, that
agent will still show up as a member of the old team in the Team
State display until the agent logs out and logs in again. After logging
in, the agent will show up as a member of the new team in the Team
State display.
The data is obtained from the Chat service. The data refresh rate is 1 second, and is
not configurable.
The graphical display of the information consists of a bar chart with ACD states on the
Y axis and the number of agents currently in each ACD state. Table 16 lists the fields
in the Team State display.
Table 16.

June 18, 2014

Team State display data

Column Name

Description

Agent Name

The agent’s name.

Agent ID

The agent’s ID.

Current State

The agent’s current ACD state.

Skill Group

The skill group ID of the call the agent is currently
servicing (in Talking state). If there is no call, or if the call
is a non-ACD call, this field is blank.

Contact Service Queue

Name of the CSQ.

State Duration

The amount of time (in seconds) that the agent has been
in the current ACD state.
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Table 16.

Team State display data (cont’d)

Column Name

Description

Reason Code

The reason why the agent is in the current ACD state.
Reason codes are available for the Not Ready and
Logout states only.

Agents – Team Summary
The Team Summary display is available when you select the Team node or Agents
node in the Agents tree.
This display presents the real time state of the agents on the selected team who are
currently logged into the ACD. By default, the data displayed is sorted in ascending
order by agent name.
NOTE: If the agent is assigned to a new team while logged in, that
agent will still show up as a member of the old team in the Team
Summary display until the agent logs out and logs in again. After
logging in, the agent will show up as a member of the new team in the
Team Summary display.
The data is obtained from the CAD Recording & Statistics service, and is for the
current day starting at midnight. The data refresh rate is configurable and ranges from
every 5 to 60 seconds. By default it is every 15 seconds.
Graphical displays of the information consist of bar charts with agent names on the Y
axis and the average amount of time (hh:mm:ss) the agent spent in a selected ACD
state. Table 17 lists the fields in the Team Summary display.
Table 17.
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Team Summary display data

Column Name

Description

Agent Name

The agent’s name.

Agent ID

The agent’s ID.

Logon Time

The total amount of time the agent has been logged into
the ACD today.

Calls Presented

The number of inbound calls (ACD and non-ACD)
presented to the agent today.

Calls Handled

The number of inbound calls (ACD and non-ACD)
presented to and answered by the agent today.

Max Talking

The longest talk time of all calls handled today.
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Table 17.

Team Summary display data (cont’d)

Column Name

Description

Avg Talking

The average talk time and hold time of all calls handled
today.

Total Talking

The total Reserved time, talk time, and hold time of all
calls handled today.

Max Ready

The longest time the agent spent in the Ready state
today.

Avg Ready

The average time the agent spent in the Ready state
today.

Total Ready

The total time the agent spent in the Ready state today.

Max Not Ready

The longest time the agent spent in the Not Ready state
today.

Avg Not Ready

The average time the agent spent in the Not Ready state
today.

Total Not Ready

The total time the agent spent in the Not Ready state
today.

Max After Call Work

Longest time spent in the Work state.

Avg After Call Work

The total time spent in the Work state divided by the
number of times spent in the Work state.

Total After Call Work

The total time spent in the Work state.

Other Time

The total time (in seconds) the agent spent in states
other than Talking, Ready, Not Ready, Reserved, and
Work since midnight.

E-Mail CSQ – Assigned
The Assigned display is available when you select a specific CSQ from the Contact
Service Queues > E-Mail tree.
Double-click any e-mail listed in the display to view the e-mail in the Agent E-Mail
Viewer.
The data is for the last seven days. The data refresh rate is configurable and ranges
from every 5 to 60 seconds. By default it is every 15 seconds.
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There is no graphical display available for these statistics. Table 18 lists the fields in
the Detail display.
Table 18.

Assigned display data

Column Name

Description

Agent Name

The agent’s name.

From

The sender of the e-mail.

To

The recipient of the e-mail.

Subject

The subject of the e-mail.

Date Received

The date the e-mail was received.

Date Queued

The date the e-mail was moved to the CSQ.

Date Retrieved

The date the e-mail was retrieved from the queue by the
agent.

E-Mail State

The agent’s current e-mail state.

Process Duration

The length of time the agent spent processing the
e-mail. Processing time includes all time that the agent
was in E-Mail Processing state with the e-mail in focus.

Draft Duration

The length of time the e-mail is in Draft state since the
agent retrieved it from the CSQ.

E-Mail CSQ – Detail
The Detail display is available when you select a specific CSQ from the Contact Service
Queues > E-Mail tree.
Double-click any e-mail listed in the display to view the e-mail in the Agent E-Mail
Viewer.
The data is for the current day starting at midnight. The data refresh rate is
configurable and ranges from every 5 to 60 seconds. By default it is every
15 seconds.
There is no graphical display available for these statistics. Table 19 lists the fields in
the Detail display.
Table 19.
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Detail display data

Column Name

Description

Agent Name

The agent’s name.
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Table 19.

Detail display data (cont’d)

Column Name

Description

Current Voice State

The agent’s current voice agent state.

Voice State Duration

The length of time the agent has been in the current
voice agent state.

Voice Reason Code

The reason code the agent selected when
transitioning to the current voice agent state.

Current E-Mail State

The agent’s current e-mail state.

E-Mail State Duration

The length of time the agent has been in the current
e-mail state.

E-Mail Reason Code

The reason code the agent selected when
transitioning to the current e-mail state.

Contact Service Queue

The name of the CSQ for which the agent is currently
handling a contact, if any.

Contact Service Queue ID

The ID of the CSQ for which the agent is handling a
contact, if any.

Media

The media type of the CSQ, Voice or E-Mail.

E-Mail CSQ – Queued
The Queued display is available when you select a specific CSQ from the Contact
Service Queues > E-Mail tree.
Double-click any e-mail listed in the display to view the e-mail in the Agent E-Mail
Viewer.
The data is for the last seven days. The data refresh rate is configurable and ranges
from every 5 to 60 seconds. By default it is every 15 seconds.
There is no graphical display available for these statistics. Table 20 lists the fields in
the Detail display.
Table 20.
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Queued display data

Column Name

Description

From

The sender of the e-mail.

To

The recipient of the e-mail.

Subject

The subject of the e-mail.
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Table 20.

Queued display data (cont’d)

Column Name

Description

Date Received

The date the e-mail was received.

Date Queued

The date the e-mail was moved to the CSQ.

E-Mail CSQ – Resolved
The Resolved display is available when you select a specific CSQ from the Contact
Service Queues > E-Mail tree.
Double-click any e-mail listed in the display to view the e-mail in the Agent E-Mail
Viewer.
The data is for the last seven days. The data refresh rate is configurable and ranges
from every 5 to 60 seconds. By default it is every 15 seconds.
There is no graphical display available for these statistics. Table 21 lists the fields in
the Detail display.
Table 21.
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Resolved display data

Column Name

Description

Agent Name

The agent’s name.

From

The sender of the e-mail.

To

The recipient of the e-mail.

Subject

The subject of the e-mail.

Date Received

The date the e-mail was received.

Date Completed

The date the e-mail was sent to the customer, or the
date the e-mail was sent to the Peer Review Queue.

E-Mail State

The agent’s current e-mail state.

Wrap-up Data

Any wrap-up data the agent entered, if the agent state
transitioned to after ending a call or sending an e-mail is
Work (after-call work).

Process Duration

The length of time the agent spent processing the
e-mail. Processing time includes all time that the agent
was in E-Mail Processing state with the e-mail in focus.

Draft Duration

The length of time the e-mail is in Draft state since the
agent retrieved it from the CSQ.
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Table 21.

Resolved display data (cont’d)

Column Name

Description

Date Reviewed

The date the e-mail is sent by the peer review agent.

Review Process
Duration

The time the peer review agent spent on the e-mail after
retrieving it from the queue.

Review Draft Duration

The time the e-mail is in Draft state since it is retrieved
from the CSQ by the peer review agent.

E-Mail CSQ – Summary
The Summary display is available when you select a specific CSQ from the Contact
Service Queues > E-Mail tree.
You can view an e-mail along with any inbound and outbound attachments in Agent
E-Mail Viewer by double clicking the email from any of the Real Time Displays.
The data is for the current day starting at midnight. The data refresh rate is
configurable and ranges from every 5 to 60 seconds. By default it is every
15 seconds.
There is no graphical display available for these statistics. Table 22 lists the fields in
the Summary display.
Table 22.
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Summary display data

Column Name

Description

Contact Service Queue

Name of the CSQ.

Agents Logged In

The number of agents in this CSQ who are currently
logged in.

Agents Processing

The number of agents in this CSQ who are currently in
the Processing E-Mail state.

Agents Ready

The number of agents in this CSQ who are currently in
the Ready state.

Agents Not Ready

The number of agents in this CSQ who are currently in
the Not Ready state.

Oldest E-Mail in Queue

Of the e-mails currently in queue for this CSQ, the length
of time in queue (in seconds) of the e-mail that has been
in the queue the longest.

Total E-Mail in Queue

The current number of e-mails in queue that have not
been routed to an agent.
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Table 22.

Summary display data (cont’d)

Column Name

Description

Total E-Mails Received

The number of e-mails routed to this CSQ since the Start
Time.

Handled Today

The number of e-mails routed through this CSQ that
agent have sent since midnight. The time of the sent
event determines whether the e-mail is included in the
count.

Average Handle

The average processing time for e-mails sent since
midnight. All the processing time is included for the
e-mail, including any time before or after midnight.

Average Response

The average response time for e-mails sent since
midnight. Response time is the difference between the
times the e-mail was received and sent. All the response
time is included for the e-mail, including any time before
or after midnight.

Longest Handle

Of the e-mails routed through the CSQ and sent since
midnight, the handle time (in seconds) for the e-mail
with the longest handle time. All the processing time is
included for the e-mail, including any time before or after
midnight.

Longest Response

Of the e-mails routed through the CSQ and sent since
midnight, the response time for the e-mail with the
longest response time (in seconds). All the response
time is included for the e-mail, including any time before
or after midnight.

E-Mail CSQ – Team Summary
The Team Summary display is available when you select the Contact Service Queues >
E-Mail node.
NOTE: If the agent is assigned to a new team while logged in, that
agent will still show up as a member of the old team in the E-mail
CSQs – Team Summary display until the agent logs out and logs in
again. After logging in, the agent will show up as a member of the new
team in the E-mail CSQs – Team Summary display.
You can view an e-mail along with any inbound and outbound attachments in Agent
E-Mail Viewer by double clicking the email from any of the Real Time Displays.
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The data is for the current day starting at midnight. The data refresh rate is
configurable and ranges from every 5 to 60 seconds. By default it is every
15 seconds.
There is no graphical display available for these statistics. Table 23 lists the fields in
the Team Summary display.
Table 23.
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Team Summary display data

Column Name

Description

Contact Service Queue

The name of the CSQ.

Agents Logged In

The number of agents currently logged in who support
the CSQ.

Agents Processing

The number of agents currently in the Processing E-Mail
state who support the CSQ.

Agents Ready

The number of agents currently in the E-Mail Ready state
who support the CSQ.

Agents Not Ready

The number of agents currently in the E-Mail Not Ready
state who support the CSQ.

Oldest E-Mail in Queue

Of the e-mails currently in queue for this CSQ, the length
of time in queue (in seconds) of the e-mail that has been
in the queue the longest.

Total E-Mail in Queue

The current number of e-mails in queue that have not
been routed to an agent.

Total E-Mails Received

The number of e-mails routed to the CSQ since midnight.

Handled Today

The number of e-mails routed through the CSQ that
agents sent since midnight. The time the e-mail was
sent determines whether the e-mail is included in this
count.

Average Handle

The average e-mail processing time for e-mails sent
since midnight. All the processing time is included for
the e-mail, including any time before or after midnight

Average Response

The average response time for e-mails sent since
midnight. Response time is the difference between the
times the e-mail was received and sent. All the response
time is included for the e-mail, including any time before
or after midnight.
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Table 23.

Team Summary display data (cont’d)

Column Name

Description

Longest Handle

Of the e-mails routed through the CSQ and sent since
midnight, the handle time (in seconds) for the e-mail
with the longest handle time. All the processing time is
included for the e-mail, including any time before or after
midnight.

Longest Response

Of the e-mails routed through the CSQ and sent since
midnight, the response time for the e-mail with the
longest response time (in seconds). All the response
time is included for the e-mail, including any time before
or after midnight.

Voice CSQ – Detail
The Voice CSQ—Detail display is available when you select a specific CSQ from the
Skill Groups tree.
This display presents information about each agent logged into the ACD and assigned
to the selected CSQ. By default, the data displayed is sorted in ascending order by
agent name.
The data is obtained from the CAD Chat service, and are for the current day starting at
midnight. The data refresh rate is 1 second, and is not configurable.
The graphical display of this information consists of a bar chart with the ACD states on
the Y axis and the number of agents on the X axis. Table 24 lists the fields in the CSQ
Detail real time display.
Table 24.
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CSQ Detail real time display data

Column Name

Description

Agent Name

The agent’s name.

Agent ID

The agent’s ID.

Current State

The agent’s current ACD state.

Skill Group

The skill group ID of the ACD call the agent is currently
servicing (in Talking state). If there is no call, or if the call
is a non-ACD call, this field is blank.

Contact Service Queue

Name of the CSQ.

State Duration

The amount of time (in seconds) that the agent has been
in the current ACD state.
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Table 24.

CSQ Detail real time display data (cont’d)

Column Name

Description

Reason Code

The reason why the agent is in the current ACD state.
Reason codes are available for the Not Ready and
Logout states only.

Voice CSQ – Summary
The CSQ — Summary display is available when you select a specific CSQ from the Skill
Groups tree.
This display presents a summary of a specific CSQ’s statistics. These statistics are
from the entire contact center, not just from members of the selected team.
The data is obtained from the CTI server unless otherwise noted, and are for the
current day starting at midnight. The data refresh rate is configurable and ranges from
every 5 to 60 seconds. By default it is every 15 seconds.
NOTE: Even though you can configure the refresh rate, it is still
dependent on how often the Enterprise service queries the CTI
service (every 10 seconds). If the refresh rate is changed to a shorter
time interval, the display will be refreshed at that interval, but the
statistics might not change until the Enterprise service receives the
updated information from the CTI service.
There is no graphical display available for these statistics. Table 25 lists the fields in
the Team Summary display.
Table 25.
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CSQ–Summary display data

Field

Description

Contact Service Queue

Name of the CSQ.

Agents Logged In

Number of agents currently logged into the system.

Agents in Talking

Number of agents currently in the Talking state.

Agents Ready

Number of agents currently in the Ready state.

Agents Not Ready

Number of agents currently in the Not Ready state.

Agents in Work

Number of agents currently in the Work state.

Agents Reserved

Number of agents currently in the Reserved state.
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CSQ–Summary display data (cont’d)

Field

Description

Current Oldest

The number of calls in queue and the elapsed wait time
of the oldest call in the queue, displayed in the format
“x [hh:mm:ss]”, where X is the number of calls and
hh:mm:ss is the elapsed wait time.

Total Calls

Total number of calls that have arrived, including calls
waiting, calls connected to agents, and calls that have
disconnected.

Handled Calls Today

Number of calls handled by the CSQ for the current
reporting period. A handled call is defined as an inbound
call (ACD and non-ACD) presented to and answered by
the agent.

Calls Abandoned

Number of calls that were routed to the CSQ but were
not answered by an agent because the caller hung up or
was disconnected.

Calls De-queued

Number of calls that were dequeued. A call is
considered to be dequeued from a particular CSQ if the
call is handled by an agent in another CSQ. This
situation can occur when a call is queued for more than
one CSQ.

Start Time

Starting date and time of the current reporting period.

End Time

Ending date and time of the current reporting period.

Talk Average

Average talk time for all calls handled by agents. Talk
time is the elapsed time between the time that an agent
connects to a call and when the call is disconnected or
transferred, not including hold time.

Average Wait Duration

Average wait time for calls routed to the CSQ. Wait time
is the elapsed time between the time a call entered the
queue and the time the call was answered by an agent
or was disconnected.

Longest Talking

Longest talk time of any one call that agents have
handled. Talk time is the elapsed time between the time
that an agent connects to a call and when the call is
disconnected or transferred, not including hold time.

Longest Waiting

Longest wait time for any one call routed to the CSQ.
Wait time is the time that elapsed between the time a
call entered the queue and the time the call was
answered by an agent or was disconnected.
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Table 25.

CSQ–Summary display data (cont’d)

Field

Description

Calls Priority 1…
Calls Priority 10

Total number of Priority N calls that were routed to each
CSQ.

Voice CSQs – Team Summary
The Team Summary display is available when you select the Skill Groups node in the
Skill Groups tree.
This display presents the details of each individual skill group, regardless of whether
or not an agent with that skill is logged in. By default, the data displayed is sorted in
ascending order by skill name.
The data is obtained from the CTI server unless otherwise noted, and are for the
current day starting at midnight. The data refresh rate is configurable and ranges from
every 5 to 60 seconds. By default it is every 15 seconds.
NOTE: Even though you can configure the refresh rate, it is still
dependent on how often the Enterprise service queries the CTI
service (every 10 seconds). If the refresh rate is changed to a shorter
time interval, the display will be refreshed at that interval, but the
statistics might not change until the Enterprise service receives the
updated information from the CTI service.
Graphical displays of this information consist of bar charts with the skill name on the
Y axis and any of the available statistics listed in the table below on the X axis,
expressed in either an integer (0, 1, 2…) or time duration (hh:mm:ss). Table 26 lists
the fields in the Team Summary display.
Table 26.
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Team Summary display data

Field

Description

Contact Service Queue

Name of the CSQ.

Agents Logged In

Number of agents currently logged into the system.

Agents in Talking

Number of agents currently in the Talking state.

Agents Ready

Number of agents currently in the Ready state.

Agents Not Ready

Number of agents currently in the Not Ready state.

Agents in Work

Number of agents currently in the Work state.

Agents Reserved

Number of agents currently in the Reserved state.
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Table 26.
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Team Summary display data (cont’d)

Field

Description

Current Oldest

The number of calls in queue and the elapsed wait time
of the oldest call in the queue, displayed in the format
“x [hh:mm:ss]”, where X is the number of calls and
hh:mm:ss is the elapsed wait time.

Total Calls

Total number of calls that have arrived, including calls
waiting, calls connected to agents, and calls that have
disconnected.

Handled Calls Today

Number of calls handled by the CSQ for the current
reporting period. A call is considered to be handled when
an agent picks up the call.

Calls Abandoned

Number of calls that were routed to the CSQ but were not
answered by an agent because the caller hung up or was
disconnected.

Calls De-queued

Number of calls that were dequeued. A call is considered
to be dequeued from a particular CSQ if the call is
handled by an agent in another CSQ. This situation can
occur when a call is queued for more than one CSQ.

Start Time

Starting date and time of the current reporting period. If
there is a failover, the start time reflects the time when
the failover occurred.

End Time

Ending date and time of the current reporting period.

Talk Average

Average talk time for all calls handled by agents. Talk
time is the elapsed time between the time that an agent
connects to a call and when the call is disconnected or
transferred, not including hold time.

Average Wait Duration

Average wait time for calls routed to the CSQ. Wait time is
the elapsed time between the time a call entered the
queue and the time the call was answered by an agent or
was disconnected.

Longest Talking

Longest talk time of any one call that agents have
handled. Talk time is the elapsed time between the time
that an agent connects to a call and when the call is
disconnected or transferred, not including hold time.

Longest Waiting

Longest wait time for any one call routed to the CSQ. Wait
time is the time that elapsed between the time a call
entered the queue and the time the call was answered by
an agent or was disconnected.
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Table 26.
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Team Summary display data (cont’d)

Field

Description

Calls Priority 1...
Calls Priority 10

Total number of Priority N calls that were routed to each
CSQ.
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Monitoring Agents
The voice monitor button enables you to silently listen in on an agent’s phone
conversations.
Voice monitoring is available whenever an agent is logged in to Agent Desktop (uses
either desktop monitoring or server monitoring) or IP Phone Agent (uses server
monitoring only). It is not available when:
■

You are a participant in a phone call (you cannot monitor yourself)

■

You use the Barge-In or Intercept function

■

In a multi-line situation, the agent is talking on the non-ACD second line
NOTE: The administrator can restrict you from monitoring an agent’s
non-ACD phone conversations.

The Voice Monitor Volume button allows you to control the volume when monitoring an
agent’s phone conversation. The system remembers your last volume setting and
uses it the next time you log in.
When monitoring a call, keep in mind the following considerations:
■

When you select a specific call from the Team View pane to monitor, all voice
activity to and from that particular agent is monitored. The monitoring is not
limited to the call you selected. For instance, if the agent puts the selected
call on hold and switches to another call, both calls will be monitored.

■

If notification is off, agents have no way of knowing if you are monitoring their
calls.

The monitored call is audible through your PC speakers. The volume slide on the
Supervisor Desktop toolbar enables you to control the volume when monitoring an
agent’s phone conversation. The system remembers your last volume setting and
uses it the next time you log in.
Monitoring sessions are on a per agent basis, and only one monitoring session can be
in progress at one time. When you select an agent from the Team View pane to
monitor, you can hear all voice activity to and from that agent. If configured by your
administrator, the monitoring session is not limited to one call. For instance, if the
agent puts an active call on hold and switches to another call, you will monitor both
calls.
You can record while monitoring an agent.
To start monitoring an agent:

1. Choose an agent in the Agents tree.
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2. Click the Start Voice Monitor button, or choose Intervention > Start Voice
Monitor.
To stop monitoring an agent:
■
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Click the Stop Voice Monitor button, or choose Intervention > Stop Voice
Monitor.
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Pushing a Web Page to an Agent
You can coach an agent by pushing a web page to that agent’s Agent Desktop
integrated browser.
To push a web page to an agent:

1. From the Agents tree, select an agent.
2. Choose Intervention > Coach by Pushing a Page. The Push URL to Agents
dialog box appears (Figure 9).
Figure 9.

Push URL to Agents dialog box

3. Enter the URL of the web page you want the agent to see, and then click Push
to send the web page to the agent. The web page you pushed to the agent is
displayed in the first tab of the agent’s integrated browser. This tab is
reserved for pushed web pages.
NOTE: There are no restrictions on what you can enter as a URL (for
example, you are not required to prefix the URL with “http://”) as long
as the URL can be resolved by a browser. Some sites require that
“http” or “https” be part of the URL.
NOTE: If the integrated browser is not enabled for the selected agent,
this operation will fail, but no error message will appear.
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Barging In On Calls
The Barge-In feature enables you to join an agent’s ACD (and if enabled by the
administrator, non-ACD) phone conversation. When you click the Barge-In button, you
are automatically added to the phone call. It is a forced conference.
NOTE: To barge in on a call, you must first be logged into Agent
Desktop.
NOTE: You can barge in only once on a call per supervisor. For
example, if you barge in on a call, drop out of the conversation, and
then attempt to barge in on the same call again, you will not be able
to do so.
If notification is enabled, the agent sees a message that you are attempting to join the
call, then sees a message that you have successfully joined it.
When you use the Barge-In feature, voice monitoring is disabled. You can, however,
record calls.
You cannot barge in if any of the following conditions are true:
■

The agent is on hold

■

The agent is on two calls

■

The agent is in a conference call

■

You are already on another call

To barge in:

1. Select an agent call in the team view pane.
2. Click the Barge-In button or choose Intervention > Barge-In. You are added to
the call.
At any time during the conference call, you can click Intercept to disconnect
the agent whose call is selected from the conference call and continue talking
with the remaining parties yourself.
To drop the barged-in call:
■
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In Agent Desktop, select the conference call from the dashboard and then
click Drop.
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Intercepting Calls
The Intercept feature enables you to intercept an agent’s ACD (and if enabled by the
administrator, non-ACD) phone conversation while disconnecting the agent from that
phone call. It is a forced transfer.
NOTE: To intercept a call, you must first be logged into Agent
Desktop.
NOTE: You can intercept a call only once. For example, if you intercept
a call, drop out of the conversation, and then attempt to intercept the
same call again, you will not be able to do so.
If notification is enabled, the agent sees a message that you are attempting to
intercept the phone call, then sees a further message when the interception is
successful.
When you use the Intercept feature, voice monitoring is disabled. You can, however,
record calls.
You cannot intercept if any of the following conditions are true:
■

The agent is on hold

■

The agent is on two calls

■

You are already on another call

To intercept a phone call:

1. Select an agent call in the team view pane.
2. Click the Intercept button or choose Intervention > Intercept. The call is
transferred to you.
If you are intercepting a conference call you are on, the agent call you
selected in the team view pane is dropped from the conference call, and all
other participants in the conference call remain connected.
To drop the intercepted call:
■
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In Agent Desktop, select the intercepted call from the dashboard and then
click Drop.
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Recording Calls
You can use Supervisor Desktop to record, save, and play back calls handled by
agents on your team. Multiple recordings can be in progress at the same time,
although only one recording can be made per agent at any one time. You use the
Supervisor Record Viewer to review recorded calls.
Recordings are made on a per call basis, and multiple recordings can be in progress
at the same time. Recordings can be made on all lines for an agent, including
non-ACD lines. However, recording non-ACD lines must be enabled by your
administrator. For instance, if an agent puts an active call on hold and starts another
call, you can record both calls, if the administrator configuration allows it.
You can use the Barge-In, Intercept, and Voice Monitor features while recording.
When recording a call, keep in mind the following considerations:
■

The recording feature is not intended to record every call. It is an on-demand
solution only.

■

When you select a call from the Team View pane to record, only the voice
activity for that particular call is recorded. The recording is limited to the call
you selected. In order to record all voice activity from an agent across all lines,
each call must be individually selected for recording. For instance, if the agent
puts the selected call on hold and switches to another call, you must select
the other call and press Record in order to record both calls.

■

Your administrator must enable recording of non-ACD calls.

■

The recording will end when the selected call terminates, or when you
manually stop recording, whichever comes first.

■

Agents can be configured so that they can start and stop recording calls.
However, an agent cannot stop a recording started by a supervisor. If an agent
attempts to do so, their Agent Desktop or IPPA interface indicates the
recording is stopped. However, the recording is not stopped, and Supervisor
Desktop displays an icon indicating that recording is proceeding.

■

You can stop a recording initiated by an agent.

■

If notification is off, agents have no way of knowing if you are recording their
calls. If an agent attempts to start recording a call that you are already
recording, the agent will see a recording icon on the call, although the agent is
not in control of the recording.

■

When you or an agent record a call, a recording license is used. The license is
released when the recording stops. If all recording licenses are in use when
you attempt to start a recording, the recording will not start.
NOTE: When you receive a message saying the recording has failed
due to the server running out of disk space, you free the space for
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new recordings by deleting the existing recordings in the Supervisor
Record Viewer.
To record a call:

1. Choose the call you want to record from the Agents tree.
2. Click the Start Record button, or choose Intervention > Call/Agent Start
Recording.
3. When you are finished, click the Stop Record button, or choose
Intervention > Call/Agent Stop Recording. The call is archived to the
Recording service database, where it is automatically saved for seven days.
NOTE: If you want to save the recording for a longer period, you can
do so for up to 30 days, after which it is deleted. For more information
on playing and saving recordings, see "Using Supervisor Record
Viewer" on page 81.
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Changing Agent ACD States
You can use Supervisor Desktop to change the ACD state of an agent on your team,
including logging an agent out.
NOTE: If you log a CAD agent out, that agent will continue to appear in
the agents tree and will be able to chat and receive team messages.
If you log out an IPPA agent, that agent disappears from the agents
tree.
To change an agent’s agent state:

1. From the Agents tree, select the agent whose state you want to change.
2. On the toolbar, click the appropriate agent state button.
NOTE: There is a delay of about 2 to 3 seconds before the command
to change agent state takes effect. To ensure you set the desired
agent state, allow enough time between clicking Agent State buttons
for the command to take effect.
NOTE: If an agent state change fails, you will not see any failure
message. You will know that an agent state change succeeds if the
icon next to the agent’s name in the team view pane changes to the
current agent state icon.
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Using Chat
Chat enables you to send instant messages to agents and supervisors on your teams.
In addition, if your configuration includes Cisco Unified Presence, you can send instant
messages to non-agents (called subject matter experts, or SMEs) who are using
Unified Personal Communicator.
Figure 10 displays the Contact Selection window of a supervisor who is also logged
into Unified Presence.
Figure 10.

Contact Selection window

This Contact Selection window
displays four contact lists, or
drawers: Agents, Supervisors,
TAC, and Engineering. The
Agents drawers is default and
are always available. The
Supervisor drawer appears only
if another supervisor is logged
in. The TAC and Engineering
drawers are examples of
customizable drawers, which
are available only when you are
logged into Unified Presence.
Note that the Engineering
drawer is closed (the members
are not visible).

Your contacts are organized in groupings called drawers. Some drawers, such as the
Agents, Supervisors, and Conference drawers, are default drawers. Any other drawers
that appear are customized by your administrator and appear only if you are logged
into Unified Presence.
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■

The Agents drawer lists all the agents on the team selected in Supervisor
Desktop. The agents’ agent state is indicated both by an icon to the left of the
agent name and by text to the right of the agent name. The agent state is
updated whenever it changes. Agents do not have to be currently logged into
Agent Desktop to be listed here, but they must have Agent Desktop open and
they must have logged in at least once.

■

The Supervisors drawer lists all supervisors on your team. Their status is
always listed as Available. Supervisors must be logged in to be listed here.

■

The Conference drawer appears when you are on a conference call with other
agents. SMEs, if they are on the conference call, are not listed here.
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■

The Personal Contacts drawer appears if you have this drawer set up in
Unified Personal Communicator. The contacts in this drawer are administered
in Unified Personal Communicator.

■

Other drawers list the SMEs associated with the work flow groups to which
your agents belong. The SMEs’ Unified Presence status is indicated both by
an icon to the left of the SME name and by text to the right of the SME name.
The Unified Presence status is updated whenever an SME status changes.
NOTE: You cannot chat with IP Phone agents.

The Contact Selection window also provides menu access to the following call
handling functions:
■

Making a call

■

Transferring a call

■

Initiating a conference call

Some Chat features include:
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■

You can send the same chat message to multiple recipients. The sending chat
window closes after the message is sent, and recipient’s replies, if any,
appear in separate chat windows, one for each person.

■

You can participate in multiple concurrent chat sessions.

■

The title bar of the Chat window displays the name of the person with whom
you are chatting.

■

If you flag a chat message as high priority, the Chat window will pop up on the
other person’s screen so that the message is noticed immediately.

■

If the priority of a chat message is normal (the default), the Chat window will
remain in its current state (open or minimized) and the corresponding icon
will flash on your Windows task bar.

■

A log of the chat messages sent between you and your chat partner (chat
history) is available as long as the Chat window is open. After you close the
Chat window, the log is lost.

■

Chat history is in chronological order, with the oldest messages at the top of
the log pane.

■

You can chat with agents who are logged out of the ACD as long as they still
have Agent Desktop open.

■

You can chat with subject matter experts (SMEs) (non-agents).

■

An agent’s ACD state is indicated by both an icon to the left of the agent name
and by text to the right of the agent name.
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■

If you are logged into Unified Presence, an SME’s Unified Presence status is
indicated both by an icon to the left of the SME name and by text to the right
of the SME name.

Table 27 lists the shortcut keys for the Chat window.
Table 27.

Chat shortcut keys

Shortcut Keys

Description

Alt+L

Starts a chat session with the person highlighted in the Chat
Selection window. If you are already chatting with the
highlighted person, Alt+L will bring that chat window to the
foreground.

Alt+C

Opens the Dialpad so you can call the person highlighted in
the Chat Selection window. The Name:Number field is
auto-populated with the selected person's extension or phone
number.

Ctrl+Shift+H

Selects the chat log pane.

Ctrl+A

Selects all the content in the selected field.

Ctrl+C

Copies the selected content to the clipboard.

Ctrl+V

Pastes the content from the clipboard into the text entry field.

Ctrl+X

Removes the selected content from the text entry field and
puts it on the clipboard.

Sending a Chat Message
To initiate a chat session:

1. On the toolbar, click Chat. The Contact Selection window appears (see
Figure 10 on page 58). This window lists the names and status of people with
whom you can chat.
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2. To chat with one person, double-click that person’s name. To chat with several
people, Ctrl+click to select their names and press Enter or choose Actions >
Chat. A Chat window opens and a session begins with the people you selected
(Figure 11).
Figure 11.

Chat session window

Chat history pane

Text entry pane

3. Type your message in the text entry field.
4. If you want your message to be noticed immediately by a pop up in the
recipient's screen, select the High priority check box.
5. Click Send or press Enter. Your message is sent to your chat partner and
logged in the chat log pane.
Replies from recipients of a group message appear in individual chat session
windows. They cannot reply to the group, they can reply only to you.
To terminate a chat session:
■
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Choose File > Close or click Close in the upper right-hand corner of the Chat
window.
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Predefined High-Priority Chat Messages
Agents might have a task button in Agent Desktop configured to send a predefined
high-priority chat message to their supervisor(s). This predefined message (for
example, “Please barge in on my call”) is set up by the administrator. It behaves just
like a regular chat message that is flagged as high priority—it pops up on your screen
on top of all other windows for your immediate attention.
You can reply to a predefined high-priority chat message from a CAD agent.

Calling Someone in Your Chat List
You can make a call, transfer a call, or conference a call to anyone listed in your
Contact Selection window using the call control actions.
NOTE: To call someone, you must be logged into Agent Desktop and
be in an agent state that allows you to make a call.
NOTE: You cannot call someone listed in your Personal Contacts
drawer.
You do not have to be chatting with an agent or SME to call them.
The call control menu items are typically disabled for SMEs. In order to make a call,
transfer a call, or conference a call to an SME on your chat list, the SME must be
configured as an External Contact by your administrator. If an SME name does not
have a phone number associated with it, the call control menu items are disabled.
To call someone in your chat list:

1. Do one of the following:
a. If you are not chatting with the person you want to call, right-click that
person’s name in the Contact Selection window and choose Call from the
resulting popup menu, or select the person’s name and then choose Call
from the Actions menu.
b. If you are chatting with the person you want to call, choose Call from the
Actions menu in the Chat Session window.
The Make a Call dial pad appears with the person’s phone number autofilled
in the Name: Number field.
2. Click Dial.
To transfer or conference a call to someone in your chat list:

1. With a call active, do one of the following:
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a. If you are not chatting with the person you want to call, right-click that
person’s name in the Contact Selection window and choose Transfer or
Conference from the resulting popup menu, or select the person’s name
and then choose Transfer or Conference from the Actions menu.
b. If you are chatting with the person you want to call, choose Transfer or
Conference from the Actions menu.
The Transfer a Call or Conference a Call dial pad appears with the person’s
phone number autofilled in the Name: Number field.
2. Click Dial.
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Monitoring Agent-Deleted E-Mail
Agents are able to delete e-mail that is delivered to their inbox. Some reasons for
deleting an e-mail are:
■

the e-mail is spam

■

the e-mail is abusive

The deleted e-mail is not actually deleted. It is transferred to an e-mail address set up
by the administrator in Cisco Desktop Administrator.
You can view a deleted e-mail either of two ways:
■

In the Agent E-Mail Viewer from its listing in the E-Mail CSQ - Resolved real
time display

■

Using a third party e-mail client (for example, Microsoft Outlook)

The Agent E-Mail Viewer only allows you to view the agent-deleted e-mail. If you want to
permanently delete the e-mail, or re-queue it to be handled by another agent, you
must use a third party e-mail client.
Consult with your system administrator for the procedure for accessing agent-deleted
e-mails.
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Reviewing Agent E-Mail
The E-Mail Review CSQ is used to review agents’ responses to customer e-mail. By
incorporating a Review CSQ into the e-mail handling process, a contact center can
ensure that any response undergoes a review before delivering it to the customer. If
an agent’s work flow group and e-mail CSQ are configured for review, then all of the
agent’s responses are transferred to the E-Mail Review CSQ.
You must use Agent Desktop to participate in the review process. See the Cisco Agent
Desktop User Guide for more information about reviewing e-mails.
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Reviewing Unified CCX Web Chat Reports
Cisco Unified CCX Web Chat enables agents to chat with customers. If configured by
your administrator, you can log in to Unified CCX Web Chat through your integrated
browser to review agent and team chat reports.

Displaying Unified CCX Web Chat
If enabled in Supervisor Desktop, Unified CCX Web Chat will appear in the first
integrated browser tab after Real Time Displays.
To enable Unified CCX Web Chat:

1. From the View menu, select Preferences. The Preferences window appears.
2. Select the Enable Cisco Web Chat check box.
3. Click OK to save your changes and dismiss the window.
NOTE: You do not also have to select the Enable Integrated Browser
check box in order for Unified CCX Web Chat to appear in the
integrated browser. If the integrated browser is not enabled, Unified
CCX Web Chat will still appear, but as the only tab.
For more information on how to use Unified CCX Web Chat, refer to the Cisco Unified
CCX Web Chat Agent and Supervisor Desktop User Guide available at:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_user_
guide_list.html
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Using the Integrated Browser
The integrated browser enables you to view intranet and internet web pages from
within Supervisor Desktop. When enabled, the browser appears as a tab in the real
time display pane, with up to 20 characters of the name of the current web page
displayed on the tab. The real time displays appear on another tab in that pane.
NOTE: You must have Internet Explorer 8 or 9 installed on your PC for
the integrated browser to function. By default, the integrated browser
is run using the Internet Explorer 8 browser version.
NOTE: Reordering of integrated browser tabs by dragging is not
supported.
By default, the browser is not enabled. See "Setting Preferences" on page 18 for
instructions on enabling the browser and configuring a home page.
The Address field’s drop-down list contains the URLs of the last 25 websites visited for
quick access to frequently-visited websites.

Browser Toolbar
The browser toolbar contains basic browser buttons that allow you to navigate among
web pages you view, refresh a current page, and return to your home page. Table 28
lists the buttons in the browser toolbar.
Table 28.

Button

—
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Name

Shortcut
Key

Description

Back

Alt+left
arrow

Returns you to the last page you viewed.

Forward

Alt+right
arrow

Takes you to the page you viewed before you
clicked the Back button.

Stop

Esc

Stops the browser from displaying a web page
(for example, if the download is taking too
long).

Refresh

F5

Refreshes the web page displayed to ensure
you see the latest content.

Home

Alt+Home

Returns you to your predefined home page.

Address

Alt+D

Selects the Address field (if configured).
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Sending Team Messages
You can send a team message to all CAD agents on a team, whether or not the agent
is logged into the ACD. As long as Agent Desktop is open, an agent can view a team
message.
NOTE: You cannot send team messages to IP Phone agents.
NOTE: If the Chat service is restarted or the server that hosts the
Chat service fails over, any active team messages are cancelled.
The Team Messages dialog box (Figure 12) stores the last 10 team messages you
broadcast. You can select any one of these messages to broadcast again. If you send
more than 10 team messages, the oldest one drops off the stored list. You cannot
designate any particular team message for permanent storage.
Figure 12.

Team Message dialog box

NOTE: By default, the team message scrolls across Agent Desktop’s
team message pane. Individual agents can set their preference in
Agent Desktop to view team messages as stationary. A stationary
team message is more compatible with screen readers, which are
often used by vision-impaired agents.
The Current Message pane displays the message that is currently being sent to your
team.
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To send a team message to all agents on a team:

1. From the team selection list, choose the team to which you want to send the
message, and then click View > Team Messages or click the Team Messages
button.
2. Type your message in the text box. The TM can be up to 255 characters long.
3. In the Expires at field, choose a specific time for the message to expire.
By default, the message runs for 30 minutes.
4. Click Start or press Enter.
The team message is sent to the team for the length of time you chose. The
text of the message you sent is logged in the current team performance
message field.
To cancel a team message:
■
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In the Team Message dialog box, click Stop.
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Creating Supervisor Work Flows
Using the Supervisor Work Flow Administrator feature, you can configure your desktop
to perform certain actions based on queue statistics for calls waiting and calls in
queue for specified skill groups.
These work flows apply only to you, not to any other supervisors, and are available to
you no matter where you log into Supervisor Desktop. They are tied to your login
information.
NOTE: Supervisor work flow actions are available at the Premium
feature level, except for the Tree Control action, which is also
available at the Enhanced feature level.
In general, work flows consist of events, thresholds, and actions.
■

The event that triggers an action is a skill group queue statistics update.
Queue statistics are updated once every 5 seconds.

■

The thresholds the event must meet is one or both of the following:

■

—

The number of calls waiting is below, within, or above specified limits

—

The oldest call in queue is below, within, or above specified time
durations

The actions triggered by meeting the thresholds can be:
—

Change the color of the skill group name in the tree control and/or add a
message next to it

—

Highlight data in the tabular real time display

—

Display a popup message on your desktop

—

Play a *.wav file on your desktop

—

Send an e-mail to selected recipients

For example, you can set up a work flow so that when there are more than 10 calls
waiting in the queue for Skill Group 6500, the skill group name in the Skill Groups tree
turns red and an audible warning sounds every 15 seconds.
To set up a supervisor work flow:

1. Choose Tools > Supervisor Work Flow Administrator.
The Supervisor Work Flow List dialog box appears.
2. Click Add.
The Add New Work Flow dialog box appears.
3. Enter a name for your new work flow, and then click OK.
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The Skill Group Selection dialog box appears.
4. Select the skill groups you want your work flow to apply to from the Available
Skill Groups pane and use the arrows to move them to the Selected Skill
Groups pane. Click OK when finished.
NOTE: A skill group might be a part of only one work flow per
supervisor.
The Supervisor Work Flow Setup dialog box appears (Figure 13).
Figure 13.

Supervisor Work Flow Setup dialog box

5. Set up the parameters for the work flow:
a. Specify the upper and lower limits for the Call Waiting and/or Current
Oldest threshold.
NOTE: When you select both Calls Waiting and Current Oldest,
the highest threshold crossed takes precedence.
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b. Select Above from the Thresholds pane.
c. Click Add. In the resulting Action Type Selection dialog box, select the
action you want to be triggered when the Calls Waiting and/or Current
Oldest statistic is above the upper limit you set, and then click OK. See
"Work Flow Actions" on page 75 for information on the types of actions
available.
d. Repeat for the Within and Below thresholds.
6. When you have finished, click OK to enable the work flow.

Example: Setting Up a Supervisor Work Flow
The following is a step-by-step illustration of setting up a supervisor work flow. This
work flow:
■

Changes the skill group name color to green and displays “Below” next to it in
the Skill Groups tree control when there are fewer than two calls waiting, or if
the current oldest call is less than one minute old.

■

Changes the skill group name color to blue and displays “Caution” when there
are 2 to 5 calls waiting, or if the current oldest call is between 1 and
5 minutes old.

■

Changes the skill group name color to red and displays “Warning” when there
are more than five calls waiting, or if the current oldest call is more than
5 minutes old.

To set up the example supervisor work flow:

1. Choose Tools > Supervisor Work Flow Administrator.
The Supervisor Work Flow List dialog box appears.
2. Click Add.
The Add New Work Flow dialog box appears.
3. Enter the name Customer Management, and then click OK.
The Skill Group Selection dialog box appears.
4. Select the skill groups you want your work flow to apply to from the Available
Skill Groups pane and use the arrows to move them to the Selected Skill
Groups pane. Click OK when finished.
The Supervisor Work Flow Setup dialog box appears.
5. Select the Calls Waiting check box and set the lower limit to 2 and the upper
limit to 5 (Figure 14).
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6. Select the Current Oldest check box and set the lower limit to 1 minute and
the upper limit to 5 minutes (Figure 14).
Figure 14.

Supervisor Work Flow Setup example

7. Select Below in the Thresholds pane and then click Add under the Actions
pane.
The Action Type Selection dialog box appears.
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8. Select Tree Control Action and then click OK (Figure 15).
Figure 15.

Action Type Selection dialog box

The Tree Control Action dialog box appears (Figure 16).
Figure 16.

Tree Control Action dialog box

9. Check Display Text and enter Below in the field.
10. Check Change Text Color, click Set Color, choose green from the color palette
displayed, and then click OK.
11. Repeat steps 7 through 10 for the Above and Within thresholds. For Above,
select “Warning” as the display text and set the color to red. For Within, select
“Caution” as the display text and set the color to blue.
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When you are finished, click OK to enable the work flow. The skill group
names will now be color-coded with text displayed (Figure 17).
Figure 17.

Skill Group names color-coded

Work Flow Actions
There are five possible work flow actions that can be triggered by threshold rules.
These actions are:
■

Audible Alert Action (page 75)

■

Message Box Action (page 76)

■

Report Action (page 77)

■

Tree Control Action (page 78)

■

E-mail Alert Action (page 78)

Audible Alert Action
The Audible Alert action plays a *.wav file on your desktop whenever the threshold
rules are met. By default, the file plays once, but you can also configure it so that it
plays repeatedly at specified intervals.
NOTE: You can turn off audible alerts that are configured to repeat at
intervals by choosing Actions > Supervisor Work Flow — Audio Off
from the menu.
Your computer most likely has system *.wav files available that are used to signal
standard Windows events. These files are a good source of sounds.
NOTE: Any *.wav file you select must be 50KB or smaller.
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To set up an audible alert, in the Audible Alert Action dialog box (Figure 18) click Add
New and then browse to the location of your selected *.wav file. If desired, set up a
repeat interval, and then click OK.
Figure 18.

Audible Alert Action dialog box

Message Box Action
The Message Box action pop ups a message box containing a customized message on
your desktop whenever the threshold rules are met. The message box is closed by
clicking OK.
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To set up a message box, in the Message Box Action dialog box (Figure 19) type your
message in the Message Text field, select the appropriate message icon, and then
click OK.
Figure 19.

Message Box Action dialog box

Report Action
The Report action highlights in color the cells in the CSQ and Oldest in Queue columns
in the tabular Team Skill Statistics real time display when the data in the cell exceeds
the threshold rules.
To set up a Report action, in the Report Action dialog box (Figure 20) click Set Color to
select the color to use for highlighting the display cells, and then click OK.
If you select the Show Team Skill Statistics Report check box, then whenever a
statistic changes that triggers a Report action, Supervisor Desktop automatically
changes its focus to display the Team Skill Statistics report so that you will see the
current report with the cells highlighted.
Figure 20.
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Tree Control Action
The Tree Control action enables you to select a color to apply to a CSQ name and/or a
message to display beside the CSQ name in the Skill Groups tree control whenever the
threshold rules are met.
To set up a Tree Control action, in the Tree Control Action dialog box (Figure 21) check
the effect(s) you want applied to the CSQ name. Click Set Color to select a text color,
enter your own message or select from the drop-down list a predefined message
(Caution or Warning) to appear next to the CSQ name, and then click OK.
Figure 21.

Tree Control Action dialog box

E-mail Alert Action
The E-mail Alert action enables you to send an e-mail to specified people whenever
the threshold rules are not met.
The e-mail messages have predefined subject lines, depending on what threshold rule
is met. They are:
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■

Skill: <CSQ name>, Number of Calls Waiting is above upper limit

■

Skill: <CSQ name>, Number of Calls Waiting is below lower limit

■

Skill: <CSQ name>, Number of Calls Waiting is within upper and lower limits

■

Skill: <CSQ name>, Oldest Call in Queue is above upper limit

■

Skill: <CSQ name>, Oldest Call in Queue is below lower limit

■

Skill: <CSQ name>, Oldest Call in Queue is within upper and lower limits
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The e-mail messages sent can consist only of the Subject line; a message in the body
of the e-mail is optional.
Figure 22.

E-mail Alert Action Setup dialog box

To set up an e-mail alert action, complete the E-mail Alert Action Setup dialog box
(Figure 22) as listed in Table 29.
Table 29.
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E-mail Alert Action Setup dialog box fields

Field

Description

From

Required. Enter your e-mail address. The first time this
dialog box is displayed the field is blank; thereafter it is
automatically filled with what you previously entered.

To

Required. Enter the e-mail addresses of the recipients,
separated by a semicolon. The first time this dialog is
displayed the field is blank; thereafter it is automatically
filled with what you previously entered.

Mail Server

Required. The SMTP IP address or host name of the
e-mail server used to send the e-mail. The first time this
dialog is displayed the field is blank; thereafter it is
automatically filled with what you previously entered.

BCC

Optional. Enter the e-mail addresses of the recipients
you want copied in on the e-mail message. The first time
this dialog is displayed the field is blank; thereafter it is
automatically filled with what you previously entered.
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Table 29.

E-mail Alert Action Setup dialog box fields (cont’d)

Field

Description

Subject

The subject line is automatically generated by the
action.

High Priority

Select the check box if you want the e-mail to be
delivered with high priority. Leave it unselected for
normal e-mail delivery.

Message Pane (not
labeled)

Optional. Enter a message to appear in the body of the
e-mail.

Use the Send button to check if the e-mail alert action is configured correctly. When
you click Send, a test e-mail is sent to the e-mail addresses in the To and BCC fields.
If the test e-mail is successful, “Mail Sent Successfully” appears in the field next to the
test button. If it is unsuccessful, “Error sending mail” appears. In that event, check
your entries in the To, BCC, and Mail Server fields for accuracy and test it again.
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Using Supervisor Record Viewer
The Supervisor Record Viewer (Figure 23) displays all recordings made by your team
over the last seven days as well as those you tag for a 30-day extended lifetime.
NOTE: Supervisor Record Viewer is a separate program from
Supervisor Desktop. Closing Supervisor Desktop will not close
Supervisor Record Viewer.
Figure 23.

Supervisor Record Viewer

Figure 24.

Supervisor Record Viewer toolbar

Play
Play & Save
Pause

Stop
Set Extended Lifetime
Set Normal Lifetime
Delete
Volume Control
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The Supervisor Record Viewer displays the information listed in Table 30.
Table 30.

Supervisor Record Viewer fields

Column Name

Description

Agent

The name of the agent whose call is recorded.

Team

The team to which the agent belongs.

Time

The time the recording was made.

Duration

The length of the recording in hh:mm:ss format.

Lifetime

The length of time the recording is archived: Normal is
7 days, Extended is 30 days.

Date Recorded

(Appears only when “Extended Lifetime” is selected in
Day Select) The date the recording was made.

NOTE: A license is used whenever a playback is in progress and
released when the playback ends. If no licenses are available when
you attempt to play back a recording, this error message is displayed:
“A licensing error has occurred. Please try again in five minutes. If the
problem persists, please see your log file or System Administrator for
details.” You must wait until a license is released and available in
order to review any recordings.
NOTE: In a High Availability system, recordings can be stored on
either of the two recording servers, and all are displayed in Supervisor
Record Viewer. If one of the servers becomes inactive and cannot be
accessed, the recordings stored on that server cannot be played,
even though they continue to be displayed in Supervisor Record
Viewer. If you attempt to play a recording stored on an inactive server,
you will see the error message, “The recording server is inactive.” You
will be able to play the recording when the server becomes active
again.
The recordings are archived as raw voice data packets; they can only be played back
using the Supervisor Record Viewer. However, if you want to save selected recordings
as WAV files, you can use the “Play and Save” button and save the recording to a
folder in WAV format.
Unless recordings are tagged for an extended lifetime, they are automatically deleted
after seven days.
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If a recording is tagged for the 30-day extended lifetime, it will not be deleted until that
30-day period expires. If you delete it manually before the 30-day period expires, it is
deleted in the next folder cleanup. Cleanups run daily at midnight.
Table 31 lists the shortcut keys for the Supervisor Record Viewer.
Table 31.

Supervisor Record Viewer shortcut keys

Shortcut Keys

Description

Ctrl+D

Selects the first option in the Day Select section. Use the left
and right arrows to navigate in the Day Select section.

Ctrl+F

Selects the first recording in the list if no other recordings are
selected.

Ctrl+S

Plays the selected recording and simultaneously saves it as a
*.wav file to the location you selected.

To start Supervisor Record Viewer:

1. From the Supervisor Desktop menu bar, choose Tools > Recorded Files.
Supervisor Record Viewer starts with current day selected.
2. From the Day Select section, click one of the option buttons to view the
recordings made by your team on that date.
To listen to a recording:

1. From the Day Select section of Supervisor Record Viewer, click the option
button for the date of the recording you want to review.
You can also click the Extended Lifetime option button to view a list of all
recordings that have been tagged for extended 30-day archiving.
2. Select the recording you want to review.
3. Click the Play button, or choose Recording > Play from the menu bar.
Use the Pause or Stop buttons to control the recording playback, and the
volume slider to control the playback volume.
There is a progress bar at the bottom of the screen that shows where you are
within the recording. You can click the progress bar and drag it backwards or
forwards to rewind or fast forward the recording. You must click Play again
after you reposition the progress bar to restart the playback.
NOTE: You cannot play back a recording while you are monitoring a
call.
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To save a recording:

1. Select the recording you want to save.
2. Click the Play and Save button, or choose Recording > Play and Save from the
menu bar. The Save As dialog box appears.
3. Select the folder where the recording is to be saved, enter a file name for the
recording, and then click Save. The recording plays and simultaneously is
saved as a *.wav file to the location you selected.
To tag a recording for extended archiving:

1. Select the recording you want to archive for 30 days.
2. Click the Set Extended Lifetime button, or choose File > Set Extended Lifetime
from the menu bar. The recording is tagged to be archived for 30 days from
the date of recording.
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Service Autorecovery
The service autorecovery feature allows Supervisor Desktop to automatically recover
its connection to the Cisco services in the event of a service restart or a network
outage.
When Supervisor Desktop detects that it is unable to communicate with a service
(generally within three minutes of the service failure), the status bar displays “Partial
Service” or “No Service” to indicate some or all of the services have failed.
When Supervisor Desktop detects that the service is again available (usually within
one minute of service recovery), the status bar displays “In Service” to indicate that
the services have recovered.
To learn more about what is affected by the service failure, double-click the status
message on the status bar. Supervisor Desktop displays a popup box (Figure 25) that
lists features and indicates if that feature is available or not due to the service outage.
Figure 25.

Service Status popup window

The agent must drop any call he or she is on in order for the phone to reconnect to the
network. If the agent continues on a call, CAD will not be able to show the call’s actual
length because it shows as “terminated” in the system.
When the phone comes back into service, the agent will see the popup window display
a message that the phone is in service. The agent can then change the agent state
back to Ready and resume taking calls.
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Phone Network Failure
In the event that an agent’s phone loses its connection to the network, the agent is
automatically moved to the Not Ready agent state, and will see a popup window
displaying a message that the phone is out of service.
The supervisor will see the change of agent state in the Agent ACD State Log report,
along with the “Device out of service” reason code (code 32759).
The agent must drop any call he or she is on in order for the phone to reconnect to the
network. If the agent continues on a call, CAD will not be able to show the call’s actual
length because it shows as “terminated” in the system.
When the phone comes back into service, the agent will see the popup window display
a message that the phone is in service. The agent can then change the agent state
back to Ready and resume taking calls.
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